
READ ME for Peterson Multimedia Guides: North American Birds 
(Windows version 1.1)

Introduction

The information contained in this file addresses many of the problems you may encounter when 
using any multimedia title. It also addresses specific problems you may encounter when running 
Peterson Multimedia Guides: North American Birds. Please take a look at the items listed in the 
table of contents to see if your particular problem is addressed.  More help on making the best 
use of all the features within North American Birds is available once you have started up the 
product (click on Options, then Help).

If you are still having problems with the CD-ROM, please call our technical support number at: 
(800) 210-0241 or e-mail us at: hmi_tech@hmco.com.

To read through this file, press Page Up and Page Down, or click in the vertical scroll bar. You can
print this file by selecting the Print command from the File menu.
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A. Install Notes

Some users may have difficulty installing Video for Windows 1.1E (VFW1.1E). VFW1.1E is 
supplied on the Peterson Multimedia Guides: North American Birds disc and should install as part
of the normal installation procedure. It will automatically overwrite any existing VFW 1.1E or 
earlier files. If it does not install properly, then you should install it directly from the Peterson 
Multimedia Guides: North American Birds disc, as follows: 

1. Put the Peterson Multimedia Guides: North American Birds disc in the CD drive.
2. In File Manager, click on the drive containing the CD.
3. Click on the VFW 1.1E directory.
4. Click on the file setup.exe.
5. Follow the on-screen instructions for installing VFW 1.1E.

B. Screen Display Notes - Images and Video

The artwork displayed in Peterson Multimedia Guides: North American Birds uses 16-bit color 
(65,000 colors) to display the full richness of the images, and we recommend that you set your 



display driver to 65,000 color mode or higher to obtain the full value of the product. You can run 
the Windows Setup program (in the "Main" program group) to identify your current driver display 
setting, and, if necessary, change your display driver. To change the Super VGA (SVGA) driver:

1. In Windows Program Manager, double-click on the Windows Setup icon in the Main program 
group.
2. Select Change System Settings from the Options menu.
3. From the Display drop-down menu, select a setting with 65,000 (65K) colors, e.g., Super VGA 
(SVGA) 800x600 65K, or 640x480 65K. 
4. You may be prompted to insert your original Windows diskettes to install the relevant driver.
5. You will be prompted to re-start Windows to activate the new display driver setting.

Please make sure that you have a back-up copy of your original
display drivers before installing the SVGA driver, in case you need to
reinstall them later.

If you are still having difficulty setting to 65K color mode, consult your display card 
documentation.

ATI Cards

Some of the advanced features of ATI cards are known to be incompatible with Peterson 
Multimedia Guides: North American Birds, in particular the more powerful ATI cards (e.g., Mach 
32). Most problems will appear in 256 color mode, but some of these problems may occur even in
high color mode as well. When you set to 65K color mode you should only encounter occasional 
video display anomalies. For more information, see your display card documentation.

Other Display Card Problems

Other cards that are known to cause display problems with Peterson Multimedia Guides: North 
American Birds including Diamond Stealth VRAM and Paradise Bahamas 64PCI. In these cases, 
we recommend you try the following steps:

1. Close all other active applications.
2. Make sure you have installed the latest version of the display card driver available from the 
manufacturer.
3. Make sure your system is set to display 65K colors.
4. Make sure you are running a double-speed CD-ROM drive or higher.
5. Consult your display card documentation.

C. Audio Problems

There are many possible causes of audio problems. Remember that your computer can only play 
one sound at a time. This means that when another application is playing a sound, Peterson 
Multimedia Guides: North American Birds will not be able to play sound. Most applications only 
prevent other programs from playing a sound when they themselves are doing so. However, 
some applications, such as certain Screen Savers, remove audio capability from all other 
Windows applications. If you have such an application, you should turn it off when you are 
running Peterson Multimedia Guides: North American Birds.

Audio is Fuzzy or Distorted

There are a number of possible reasons for fuzzy or distorted sounds. These problems are often 
caused by low quality speakers, set to high or maximum volume, or powered by failing batteries. 
You should also be aware that some speakers are not capable of playing low frequency sounds 



properly.

Powered speakers are best and should, if possible, be placed either side of your monitor. You 
may need to adjust the position of the speakers slightly if the magnets in the speakers are 
unshielded and cause discoloration and distortion of the image on your monitor.

If the software supplied with your sound card allows you to change settings you should check 
your settings to see if they are causing the distortion.

Some sound cards have software that allows you to adjust the volume as well as the tone of the 
sound; if this is the case with your sound card, start with these tone controls set in the mid 
position and your main volume level (and wave volume if you have this) is set between 80% - 
100%. This should give a clear signal with no distortion. Check your sound card documentation 
for the optimum settings.

If your CD-ROM is not MPC compatible, then the sound may play badly or be interrupted when 
playing. Verify that your CD-ROM drive is MPC compatible, so that it meets the following 
requirements:

1. It has an average seek time of less than one second; 
2. It has a transfer rate of at least 150KB per second while using less than 40% of the CPU 
bandwidth.

Sound Plays Too Quietly

Make sure the volume is set to an audible level. Check the sound card itself, the speakers or 
headphones if they have a volume control, and any software that may have been supplied with 
your sound card that can change the volume level.  If there is a mute button in the audio software 
or on the speakers, check that this is not activated.

If sound is set to an audible level, then you may have a problem with the way your sound card 
drivers are set up. Check they are set up correctly (from the DRIVERS section of the CONTROL 
PANEL in the MAIN program group) and, if necessary, reinstall them. Consult your sound card 
documentation for more detailed information.

D. CD-ROM Problems

Should Peterson Multimedia Guides: North American Birds have problems finding the data files it 
needs from its CD-ROM, you may see a message asking you to select the drive that contains the 
files, or you may see an error message with the options to abort, retry or fail. To find what has 
caused the problem, do the following:

1. Ensure that the Peterson Multimedia Guides: North American Birds CD has been correctly 
inserted into the CD-ROM drive.
2. If you have an external CD-ROM drive, check  that it is plugged in, turned on, and connected to
your computer. You may need to check the documentation that came with the drive.
3. Check that Peterson Multimedia Guides: North American Birds is looking in the right place for 
the CD-ROM drive. If, for example, the drive letter has changed as a result of a system change 
(like adding or removing a RAM disk or another device) then Peterson Multimedia Guides: North 
American Birds will fail to find its CD-ROM. You can check that the drive letter is correct by using 
Windows File Manager to see which letter is assigned to the CD-ROM drive.  If you are running 
Peterson Multimedia Guides: North American Birds under Windows 95, check the drive letter is 
correct by double clicking on the MY COMPUTER icon and then looking underneath the icon
which represents your CD-ROM drive.
4. Verify that your CD-ROM drive is MPC compatible, so that it meets the following requirements:



- It has an average seek time of less than one second;
- It has a transfer rate of 150KB per second while using less than 40%
of the CPU bandwidth.
5. Check that your CD is clean and dust free following the instructions below in section K.

VSHARE.386

The following problems may result from running Peterson Multimedia Guides: North American 
Birds  without VSHARE.386. The product requires this file to ensure database integrity. If 
VSHARE.386 is not installed correctly, or if the older, outdated file SHARE.EXE is loading instead
of, or in addition to VSHARE.386, the errors below will occur.

- An error message: "Share.exe not loaded or inaccessible"
- An error message: "Unable to add to Lifelist"
- Filtered searches in Bird Finder return too few or zero birds.

The following steps will resolve these problems:
1. Make sure that VSHARE.386 exists, and is located in the WINDOWS\SYSTEM directory. 
VSHARE.386 comes with Windows 3.11 and Windows 95, but not with Windows 3.1. If you do 
not have VSHARE.386, you can download the latest version from HMI Support's website 
(http://www.hminet.com/support/cd-roms).
2. Use a text editor to open the SYSTEM.INI file. Usually the easiest way to do this is to choose 
"Run" from the "File" menu in Windows 3.x, or by choosing "Run" from the Start button menu in 
Windows 95. At the command line, type"SYSEDIT.EXE" (without the quotes). Then click "OK". 
3. Choose the Window labeled "SYSTEM.INI" and scroll down through this file until you see a 
section that begins with the line "[386 Enh]". Make sure there is a line in this section that says 
"device=VSHARE.386". Capitalization is not important. If there is no such line, add it, making sure
it is in the correct section.  
4. Save and Close the file. 
5. Choose the window labeled AUTOEXEC.BAT and page through it, making sure that there is no
line anywhere in the file that looks like "c:\DOS\SHARE.EXE" or "LH C:\DOS\SHARE.EXE". If 
there is, insert the letters "REM" at the beginning of that line. Also check CONFIG.SYS for such a 
line, and insert "REM" at the beginning of any such lines.
6. Close SYSEDIT and Save all changes. Quit Windows and restart your computer.

CODECS

In order to play video and audio in the Peterson Multimedia Guides: North American Birds, 
Windows uses files called "codecs" to compress and decompress the video and audio files. If 
these codecs are not installed properly or are damaged, any of the below errors can occur.

Error: Cannot load species art
Error: Unable to load images
Error: Video not available (Win95)
Error: Unable to load hotspot
Error: Invalid Page fault in MSRLE32.DLL
Error: Error in MMSYSTEM296
Error: Unable to play on specified MCI device
Error: Video requires VIDC:CVID
Error: PIB caused a GPF in MMTASK (or MMSYSTEM)
No sound in video
Other GPF errors 

In Windows 3.x:

The codecs you need should be installed by the Microsoft Video for Windows Installer, which runs



when you first install the Peterson Multimedia Guides: North American Birds. Microsoft Video for 
Windows probably did not install properly. Reinstall Microsoft Video for Windows by choosing 
"Run" from the File menu and finding SETUP.EXE in the VFW11E directory on the CD. Then 
reboot and try running the program again.

If that doesn't work, the codecs may be damaged. The Video for Windows Installer doesn't 
overwrite the files when it runs, so you may have to remove them yourself. First, you will have to 
disable the codecs so that Windows will allow you to remove them. Choose "Run" from the File 
Menu, and at the command line, type "SYSEDIT". Choose the window that appears that is titled 
"SYSTEM.INI". Page through this file until you get to a section called "[drivers]" in this section 
there should be about five or six lines that begin with the letters "VIDC" (for VIDeo Compression). 
Insert a semicolon at the beginning of each of these lines. Close and save the file, and restart 
Windows. Then use File Manager to rename the following files: 

MSVIDC.DRV 
INDEOV.DRV 
IR32.DLL 
IR32.DLL 
MSRLE.DRV 
IR21_R.DLL 

Then, reinstall Video for Windows. 

If that doesn't work, you may not have enough virtual or physical memory to load the images. See
above for info on memory problems with the Peterson Multimedia Guides: North American Birds. 

In Windows 95: 

The situation is a bit more complicated. Windows 95 comes with updated 32-bit codecs that 
supercede the ones installed by Video for Windows. Nevertheless, if you run the Video for 
Windows installer, it will install the old 16-bit codecs anyway. Either set of codecs will work with 
the Peterson Multimedia Guides: North American Birds, but Microsoft discourages having both 
sets installed at the same time, since they can corrupt each other. Due to this effect, sometimes 
the errors above will appear even after the product had been working fine at first. If you have run 
the Video for Windows installer and are running Windows 95, we recommend that you disable the
16-bit codecs and reinstall the 32-bit codecs to make sure they are not corrupted. 

1.Click the "Start" button, and then choose "Run". At the command line, type "SYSEDIT".
2.Choose the window that is titled "SYSTEM.INI" and page through it until you find a section that 
begins with "[drivers]". Insert a semicolon at the beginning of every line that begins with the letters
"VIDC". 
3.Open the "Add/Remove Programs" Control Panel. 
4.Click on the "Windows Setup" tab, then click on "Multimedia", taking care not to uncheck the 
checkbox. 
5.Under the "Multimedia" branch, there should be an item that says "Video Compression". 
Uncheck the checkbox next to it, and click "OK" when Windows 95 asks you if you want to 
remove the video compression drivers. 
6.Restart Windows 95. 
7.Go back to the "Add/Remove Programs" control panel, click on "Windows Setup" again, and 
then "Multimedia" and find the  "Video Compression" box once again. This time, check the 
checkbox. Windows 95 will as you for the Windows 95 CD or for Windows 95 floppy disk number. 
8. Provide this disk and click OK. It will then decompress and install the fresh video codecs. If it 
did not ask for the Windows 95 disk, you will have to remove the codecs again, since instead of 
deleting them, Windows 95 merely disabled the old and possibly corrupted codecs. Now restart 
your computer. 



A similar process can be followed for audio codecs. 

E. Running Out Of Memory Or Running Slowly

Peterson Multimedia Guides: North American Birds uses your computer's system memory to 
display pictures. If you find that Peterson Multimedia Guides: North American Birds runs slowly or
if you encounter out-of-memory errors, the program probably does not have enough memory. 
Consider doing the following to improve your computer's performance:

1. Close any unnecessary applications.
2. Check that your computer has at least 8MB of memory. You can do
this by leaving Windows, and typing "mem" at the system prompt.
Look for total memory in the Total column.  If the figure reads 8,192 or
more, then you have at least 8MB of memory.  If you have less than
8MB  (minimum of 8192KB) of memory, then you need to install some
more.
3. Check that Windows has sufficient memory available for Peterson Multimedia Guides: North 
American Birds. You can do this by selecting "About Program Manager" from the
"Help" menu in Program Manager.  If you are running Peterson Multimedia Guides: North 
American Birds under Windows 95 you can do this by double clicking on the MY
COMPUTER icon, then select HELP.  The memory available should
be at least 8,192 KB.  You may find more memory becomes available
if you restart Windows.  If the figure is less than 8,192KB, you should
follow step 4, below.
4. Clean up your hard disk by defragmenting it. There are a number of
tools available to carry out this task, including the DEFRAG command
found in MS-DOS version 6 and later.
5. If you are running DOS 6.0 or higher, then you can run the
MEMMAKER utility to optimize the memory in your computer.  For
example, if you answer 'No' to the question 'Do you use any programs
that need Expanded Memory?', MEMMAKER will free further
conventional memory by inserting the switch NOEMS in the
appropriate line in your PC's CONFIG.SYS file.  Consult your
Windows documentation for further information on using
MEMMAKER.
6. Check that MSCDEX which appears in the AUTOEXEC.BAT file is
version 2.23 or later.  You can do this by typing "MSCDEX" at the
system prompt in MS-DOS.  If in any event no version number is
given, then you can be sure that your version of MSCDEX is older
than version 2.23.  Versions of MSCDEX which are older than 2.23
should be upgraded.

F. Network Problems

If you are running Peterson Multimedia Guides: North American Birds while connected to a 
network, you may get an error message that the ODBC MS Access 2.0 Couldn't lock file: 
share.exe hasn't been loaded. To resolve the problem, you can either:

1. Quit the network access, restart Windows, and restart Peterson Multimedia Guides: North 
American Birds.
2. Edit your autoexec.bat file by adding this line: c:\DOS\share.exe.

G. Windows 95 and Peterson Multimedia Guides: North American Birds



Sound Decompression Drivers

The following problems may result from running Peterson Multimedia Guides: North American 
Birds under Windows 95 without the sound decompression drivers supplied with Windows 95:

- An error message when running about "ADPCM" drivers.
- Unintelligible sound output from Peterson Multimedia Guides: North American Birds
- Speeded up sound in some parts of Peterson Multimedia Guides: North American Birds

To overcome any of these problems we suggest using the sound decompression drivers supplied 
with Windows 95.  To do this:

1. From the Start Menu, choose "settings", then choose "Control Panel".
2. Click the "Add/Remove Programs" icon.  The "Add/Remove Programs Properties" dialogue box
will appear.
3. Select the "Windows Setup" tab.
4. Highlight the "Multimedia" option in the list, then select the details button.  The Multimedia 
dialogue box will appear.
5. If the "Audio Compression" box is not checked, you should do this now.  Click "OK" and then 
follow the instructions which appear on the screen.
6. If the "Audio Compression" box is checked, you should click to deselect it first. Select "OK", 
and then follow the instructions which appear on the screen.  Finally repeat the whole operation 
to re-check the "Audio Compression" box.  This ensures that the up-to-date
drivers are actually installed by Windows 95, and it doesn't just 'think' they are.

If the above steps do not help, you should ensure that the system does not have a third party 
ADPCM driver installed or that the priority for decompression drivers is wrong.  To do this:

1. From the Start Menu, choose "settings", then choose "Control Panel".
2. Click  the Multimedia icon.  The "Multimedia Properties" dialogue will now appear.
3. Select the "Advanced" tab.
4. Click the "+" symbol next to "Audio Compression Codecs".
5. Ensure that the top three CODECS are listed in the same order shown below:
- Microsoft CCITT G.711 A-Law and u-Law CODEC
- Microsoft IMA ADPCM CODEC
- Microsoft ADPCM CODEC
If they are, there is another problem with the sound card software.
6. If the CODECS are not listed in the order specified above, you should select the top three 
CODECS in the list, and click the properties button, one at a time.
7.  For each CODEC you do this to a dialogue will appear which allows you change the priority 
setting of the CODEC to move it further in the list.

If the above procedure does not solve your problem you may also try the following steps to 
disable all CODECS listed with the text "ADPCM" (apart from "Microsoft ADPCM CODEC"):

1. From the Start Menu, choose "settings", then choose "Control
Panel".
2. Click  the Multimedia icon.  The "Multimedia Properties" dialogue will now appear.
3. Select the "Advanced" tab.
4. Select the CODEC to disable.
5. Select the properties tab to display the dialogue above to the right.
6. Select "Do not use this audio codec".
7. Select "OK".  Repeat the procedure for all other relevant CODECs.



H. Internet Access Setup

Peterson Multimedia Guides: North American Birds includes a feature that will set up your web 
browser for easy access to the Internet. (Your browser must be installed prior to setting up 
Internet access with this product.)  While in the product, just click the Online button.  The product 
will launch your browser and take you directly to Peterson Online 
(http://www.petersononline.com).  Setup also creates web-linked icons that launch your browser 
and take you directly to Peterson Online or HMI Net (http://www.hminet.com) from your desktop. 

Windows
1.  From product installation:
During installation of North American Birds, you will be given the choice of setting up your 
currently installed Internet browser or setting it up later.  If you choose to setup access, and have 
Netscape Navigator or Microsoft Internet Explorer, the setup program will locate and prompt you 
to use it.  If you wish to use a different installed web browser, the setup program will ask you to 
locate it first.  See below for help locating your browser.  

2.  From the desktop:
If you skipped Internet access setup during the product installation, you may initiate it by double-
clicking the Internet Access Setup icon.  If you have Netscape Navigator or Microsoft Internet 
Explorer, the setup program will locate and prompt you to use it.  If you wish to use a different 
installed web browser, the setup program will ask you to locate it first.  See below for help locating
your browser.  

I. Locating your Internet Browser

Windows 95
1.  Right click once on the browser's desktop icon, choose Properties, and select the Shortcuts 
tab.  
2.  The Target line is the browser's location and filename.

Windows 3.1
1.  Left click once on the browser's desktop icon and select Properties from the File menu.  
2.  The Command Line is the browser's location and filename.

J. Peterson Online

The Peterson Online web site (http://www.petersononline.com) is optimized for Netscape 2.0 (and
later) and Microsoft Internet Explorer 2.0 (and later).  If you are running an earlier version of these
browsers, please contact your online service or Internet provider for an upgrade.

K. Care of Compact Discs

Contrary to early reports, compact discs are very easily damaged and
if treated carelessly, may eventually become unreadable.  With CD-
ROM drives becoming ever faster and more disc sensitive, this is
becoming an increasing problem.

When removing the CD-ROM from its case, grip the CD by the edges.

A compact disc is made from two thin layers of polycarbonate
sandwiching the data encoded reflective surface.  The surface of the
disc is very easily scratched.  Normally a CD-ROM drive can cope



with small surface scratches without any problems.  However, if these
scratches are too long, too deep or too numerous the CD-ROM drive
may have problems reading the data.

Similar problems will result from dirt and grease accumulating on the playing surface. To avoid 
getting dirt on the disc, always hold it by the edges, and never touch the playing surface.

Should the disc become dirty of scratched, clean the surface with a
lens cloth, using a small radial action.  Should the disc be very dirty,
use a proprietary CD cleaner or a lens cloth with a CD cleaning fluid.
Should the disc be badly scratched, there are CD cleaners available
that will repair some of this damage.

Compact Discs should also be kept well away from extreme heat, as
this can warp the disc or damage the surface.

L.  About Houghton Mifflin Interactive

Houghton Mifflin Interactive titles are available wherever CD-ROMs
are sold.  New titles will be available on a regular basis. For more
information, contact us at Houghton Mifflin Interactive, 120 Beacon Street, Somerville, MA 02143,
PH: (617) 503-4800.

You may also visit our sites on the Internet:

http://www.hminet.com (or) http://www.petersononline.com
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